Connex® Device Integration Suite (CDIS)
Network Connectivity Engine (NCE) software

CP 100™ and CP 200™ electrocardiographs
Spot Vital Signs® LX™ vital signs device
Connex Vital Signs Monitor® 6000 series
CP 50™ electrocardiograph
CP 150™ electrocardiograph
Connex® Spot Monitor

Installation guide
Software version 5.0.X
# Contents

1 - Overview ............................................................... 1
   About this guide ........................................... 1
   General warnings and cautions ...................................... 1
   System requirements ............................................. 2
   About CDIS-NCE software ........................................ 3
   Spot LXi, Connex VSM 6000, and Connex Spot Monitor configuration examples 4
   CP 50, CP 100, CP 150, and CP 200 configuration examples .......... 5

2 - Installation .......................................................... 7
   Spot LXi, Connex VSM 6000 Series, and Connex Spot Monitor ......... 7
   CP 50, CP 100, CP 150, or CP 200 .................................. 10

3 - Configuration ......................................................... 13
   Configuring the CP 50, CP 150, and CP 200 patient-match criteria (resolving patients) ...................................... 13
   Configuring the CardioPerfect Workstation for non-Welch Allyn devices ........................................ 15
   NCE configuration ............................................. 17
   File Importer configuration ...................................... 30

4 - Troubleshooting ..................................................... 33
   About the connectivity software modules ................................ 33
   Reassigning a server IP address ................................... 37
   Troubleshooting chart ........................................... 38
Welch Allyn Connex® Device Integration Suite (CDIS) Network Connectivity Engine (NCE) software
Overview

About this guide

This guide describes how to install, configure, and troubleshoot the Welch Allyn Connex Device Integration Suite (CDIS) - Network Connectivity Engine (NCE) software.

For related procedures — for example, configuring the CP 150 electrocardiograph for connectivity, installing the wireless radio, or installing the CardioPerfect Workstation software — see separate instructions for the specific product.

For details on HL7 connectivity, contact your Welch Allyn service representative.

This guide is written for network administrators and others with a background in information technology.

General warnings and cautions

Throughout this manual, warning statements indicate conditions or practices that could lead to illness, injury, or death. Caution statements indicate conditions or practices that could damage the equipment or other property.

⚠️ WARNING Reanalyzing imported ECG or spirometry data at a CardioPerfect Workstation might affect measurement values and predicted values due to platform differences, possibly changing the automatic interpretation.
System requirements

Operating systems

| Client PC    | Windows 7 (x86 and x64), Windows 8 (x86 and x64), Windows 8.1 (x86 and x64). |
| Computer requirements | Any computer may be used that meets the selected operating system requirements. |
|              | RAM required to support application: 16 MB (Typical); 64 MB (Maximum) |
|              | Storage required to support application: 20 MB (Typical); 2 GB (approximate maximum) when using debug features. |

**Note:** The CP 200 (software version 2.6 or lower) requires an upgrade to 2.6 or higher to operate with CDIS-NCE.

**Note:** An Internet connection is required for installation and first time operation.

**Note:** .NET 3.5 is required for CP ECG and Spirometer device connectivity to the CPWS.
About CDIS-NCE software

The Welch Allyn CDIS-NCE software is a collection of software modules that enable various Welch Allyn devices to communicate with systems such as HL7 host systems and Welch Allyn CardioPerfect Workstations.

From a connected device, you can do the following:

- Send vitals data to data systems.
- Send ECG and/or spirometry tests to a CardioPerfect database.
- Recall patient information from a CardioPerfect database (CP 50 and CP 150 only).
- Retrieve patient lists from an EMR/HIS using a Welch Allyn HL7 interface, sold separately (Connex VSM, CP 50, and CP 150 only).

Even without a connection, users of CP 50, CP 100, CP 150 and CP 200 electrocardiographs can transfer tests to a CardioPerfect database via removable media (SD memory cards or USB storage devices).

<table>
<thead>
<tr>
<th>Device</th>
<th>WiFi</th>
<th>Ethernet</th>
<th>USB</th>
<th>Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP 50</td>
<td></td>
<td></td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>CP 100</td>
<td></td>
<td></td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>CP 150</td>
<td>☑</td>
<td></td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>CP 200</td>
<td>☑</td>
<td></td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Spot LXi</td>
<td>a, b</td>
<td></td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Connex VSM 6000</td>
<td>b</td>
<td></td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Connex Spot Monitor</td>
<td>b</td>
<td></td>
<td>☑</td>
<td>☑</td>
</tr>
</tbody>
</table>

a. 802.11. b. Note: Welch Allyn supports two radio models for Spot LXi. b. 802.11 a/b/g.
Spot LXi, Connex VSM 6000, and Connex Spot Monitor configuration examples

Client-server network configuration, wireless or Ethernet

Server
Installation menu option: “Server”

Workstation (client)
Installation menu option: “Client”

USB cable

Functional diagram:
“Software modules in a simple network configuration, wireless or Ethernet” on page 36

Client-server configuration

Functional diagram:
“Software modules in a USB configuration” on page 36
CP 50, CP 100, CP 150, and CP 200 configuration examples

Standalone configuration, removable media or USB

Client-server configuration, removable media or USB
Overview Welch Allyn Connex® Device Integration Suite (CDIS) Network Connectivity Engine (NCE) software

Ethernet network configuration

Functional diagram:
“Software modules in a client-server and Ethernet network configuration” on page 35
Spot LXi, Connex VSM 6000 Series, and Connex Spot Monitor

Before you install the Welch Allyn CDIS-NCE software do the following:

- Verify that the connectivity settings in the device software are properly configured. For details, see the device’s directions for use.

- If using wireless communications, check the device’s settings. Verify that these settings match the access point settings.

- Close all programs before starting the installation.

To install the Welch Allyn CDIS-NCE software

Before you begin the process of installing the CDIS-NCE software, run the wizard as administrator:

- Select the "Command Prompt" program, select 'Run as administrator'.
- Run the "Connectivity Install.hta" installation program from the "Command Prompt".

1. Start the CDIS-NCE Installation Program. This screen appears:
2. Select **SPOT LXi** or **CVSM / Connex Spot Monitor**.

3. Select **Next** to continue. This screen appears:

4. Choose either **Server** or **Client** based on your configuration.

   For illustrations, see “Spot LXi, Connex VSM 6000, and Connex Spot Monitor configuration examples” on page 4.

5. Select **Finish** to complete the installation.
To uninstall the Welch Allyn CDIS-NCE software

Before you begin the process of uninstalling the CDIS-NCE software, run the wizard as administrator:

- Select the "Command Prompt" program and select 'Run as administrator'.
- Run the "Connectivity Install.hta" installation program from the "Command Prompt".

1. Start the CDIS-NCE Installation Program. This screen appears:

2. Select the **Uninstall** button.

3. Follow the instructions on the screen:
   - Select **Yes** to continue.
   - Select **OK** to close the uninstall wizard.
   - Select **Cancel** to complete the process.
   - Select **Close** to exit the application.
CP 50, CP 100, CP 150, or CP 200

Before you install the Welch Allyn CDIS-NCE software do the following:

- If connecting to a CardioPerfect Workstation, do the following:
  - Verify that the CardioPerfect Workstation software and database have both been upgraded to version 1.6.0 or higher. If necessary, upgrade the software and database now.
  - When using a stand-alone CardioPerfect Workstation system, please install the server software on the stand-alone CardioPerfect Workstation system.
  - When using a client/server configuration, please install the server software on the CardioPerfect Workstation database server before installing the clients.
  - Configure the ECG/Spirometry device for DOB setting (not age) so that the ECG will be properly imported into the CardioPerfect Workstation.

- Verify that the connectivity settings in the software are properly configured. For details, see the electrocardiograph directions for use.

- Make sure .NET 3.5 is installed on the computer.
  - Go to the control panel and add .NET 3.5 as an OS feature.
  - Close all programs before starting the installation.

Note  The CP products must be configured to use DOB (not age) to properly transfer data from the CP products to CPWS.

To install the Welch Allyn CDIS-NCE software

Before you begin the process of installing the CDIS-NCE software, run the wizard as administrator:

- Select the "Command Prompt" program, select "Run as administrator".
- Run the "Connectivity Install.hta" installation program from the "Command Prompt".

1. Start the CDIS-NCE Installation Program. This screen appears:
2. Select **CP50/100/150/200**. This screen appears:

3. Select **Next** to continue. This screen appears:

4. Choose either **Server** or **Client** based on your configuration.
   For illustrations, see “**CP 50, CP 100, CP 150, and CP 200 configuration examples**” on page 5.

5. Select **Finish** to complete the installation.
To uninstall the Welch Allyn CDIS-NCE software

Before you begin the process of uninstalling the CDIS-NCE software, run the wizard as administrator:

- Select the "Command Prompt" program and select 'Run as administrator'.
- Run the "Connectivity Install.hta" installation program from the "Command Prompt".

1. Start the CDIS-NCE Installation Program. This screen appears:

2. Select the **Uninstall** button.

3. Follow the instructions on the screen:
   - Select **Yes** to continue.
   - Select **OK** to close the uninstall wizard.

   - Select **Cancel** to complete the process.
   - Select **Close** to exit the application.
Configuring the CP 50, CP 150, and CP 200 patient-match criteria (resolving patients)

When a test is imported into the CardioPerfect database, the patient data submitted with the test may or may not match patient data already stored in the database. The software tries to match, or resolve, the incoming data against the stored data. Tests are entered either for an existing patient or for a new patient, depending on the patient-match criteria.

MRN (medical record number) is a unique piece of text that identifies a patient. It is usually a number, but it sometimes includes other information, such as social security number or last name.

If the criteria are only partially satisfied, a suspect record may be created (.SUSPECT is appended to the MRN).

The file named CPWS.Operations.CPWSImportTest provides a method of inserting a test into the database. If the test already exists, it is replaced with the new test. Either the patient indicated in the test is matched to a patient already in the database, or a new patient is created. The criteria are controlled by the PatientMatchCriteria appSetting in App.config (which compiles into CPWS.Service.exe.config).

To configure the patient-match criteria
1. Open this file: C:\Program Files\Welch Allyn\CPSAPI\CPWS.Service.exe.config.

   Note: On 64-bit systems, the file path is C:\Program Files (x86)\Welch Allyn\CPSAPI\CPWS.Service.exe.config.

   Windows 7 users: Open this file as an administrator, as follows:
   a. Click the Start button. Select All Programs > Accessories.
   b. Right-click Notepad. Select Run as Administrator. Notepad opens.
   c. Click File > Open. Open CPWS.Service.exe.config.

2. Replace the key attribute with the desired PatientMatchCriteria value in this line:
   <add key="PatientMatchCriteria" value="MATCH_MRN"/>
3. Save the file.

4. Restart the CPSAPI service. (Go to Control Panel > Administrative Tools > Services. Right-click CardioPerfect Services. Select Restart.)

<table>
<thead>
<tr>
<th>PatientMatchCriteria</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MATCH_MRN</td>
<td>This is the default setting. The MRN must match exactly. If the MRN is empty, the record is marked suspect.</td>
</tr>
<tr>
<td>MATCH_MRNDOB_GENDER</td>
<td>The MRN, date of birth and gender must match exactly. If this fails but the MRN matches or is empty, the record is marked suspect.</td>
</tr>
<tr>
<td>MATCH_MRNDOB_GENDER_LASTNAME</td>
<td>The MRN, date of birth, gender and last name must match exactly (case-insensitive). If this fails but the MRN matches or is empty, the record is marked suspect.</td>
</tr>
<tr>
<td>MATCHDOB_LASTNAMEFIRSTNAME</td>
<td>The first name and last name must match exactly, and the date of birth must be on the same day.</td>
</tr>
<tr>
<td></td>
<td>• If there is no match, but the MRN conflicts with another entry, the record is marked suspect.</td>
</tr>
<tr>
<td></td>
<td>• If there is no match and the MRN is blank, the MRN is set to a period, the patient’s last name, a period, and a unique number.</td>
</tr>
<tr>
<td></td>
<td>This is the only setting that allows a blank MRN, which gets automatically generated.</td>
</tr>
</tbody>
</table>
Configuring the CardioPerfect Workstation for non-Welch Allyn devices

CardioPerfect Workstation uses the SCP-ECG plug-in, which is a standard communications protocol for computer-assisted electrocardiography (EC71 or EN1064). This plug-in, which works with the CPSAPI software module, enables you to configure the CardioPerfect Workstation software to import resting ECG tests from non-Welch Allyn devices and to export ECG tests to non-Welch Allyn record management systems using a format translator, for example Datamed (sold separately).

To configure CPSAPI plug-ins, you modify an XML configuration file, and then restart the CardioPerfect Services service.

The plug-in file, named `CPSAPI.config`, is stored in the local folder with the CPSAPI service executable. By default, this folder is `C:\Program Files\Welch Allyn\CPSAPI`. On 64-bit operating systems, the path is `C:\Program Files (x86)\Welch Allyn\CPSAPI`.

For a description of the CPSAPI module, see “Configuring the CP 50, CP 150, and CP 200 patient-match criteria (resolving patients)” on page 13.

**To configure the plug-in for automatic ECG exporting**

This procedure configures the CardioPerfect program to export ECG tests from the CardioPerfect database automatically when they are captured and saved in the specified folder.

1. Find the SCP-ECG Collector entry in `CPSAPI.config`.

   Example:

   ```xml
   <ResultCollector name="SCP-ECG Collector" enabled="1" standalone="1" type="CPWS.Plugins.ResultCollector.SCPECGCollector,CPWS.Plugins" values="" destinationfolder="specify export folder here" />
   ```

2. Modify the `enabled` and `destinationfolder` attributes as desired.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>enabled</td>
<td>Specifies whether CPSAPI should load and execute the plug-in.</td>
<td>0 (Off), 1 (On)</td>
</tr>
<tr>
<td>destinationfolder</td>
<td>Specifies the output folder where SCP-ECG files will be created. Caution: The destination and source (export and import) folder names must be unique. If these folder names are identical, the system will not operate properly.</td>
<td>Any valid Windows path</td>
</tr>
</tbody>
</table>

3. Restart the CPSAPI service.
   a. Go to Control Panel > Administrative Tools > Services.
   b. Right-click CardioPerfect Services.
   c. Select Restart.
To configure the plug-in for automatic ECG importing

This procedure configures the CardioPerfect program to import ECG tests into the CardioPerfect database automatically when new SCP files appear in the specified folder.

1. Find the TestFileImporter entry in CPSAPI.config.

   Example:

   `<TestFileImporter name="SCP-ECG Test Importer" enabled="1" type="CPWS.Plugins.TestFileImporter.SCPTestFileImporter,CPWS.Plugins" sourcefolder="specify import folder here" />
   
   `  

2. Modify the enabled and sourcefolder attributes as desired.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>enabled</td>
<td>Specifies whether CPSAPI should load and execute the plug-in.</td>
<td>0 (Off), 1 (On)</td>
</tr>
<tr>
<td>sourcefolder</td>
<td>Specifies the import folder for incoming SCP-ECG files. Caution: The destination and source (export and import) folder names must be unique. If these folder names are identical, the system will not operate properly.</td>
<td>Any valid Windows path</td>
</tr>
</tbody>
</table>

3. Restart the CPSAPI service.
   a. Go to Control Panel > Administrative Tools > Services.
   b. Right-click CardioPerfect Services.
   c. Select Restart.
NCE configuration

The NCE application acts as a gateway between devices and external information hosts. The configuration interface is described in the following section.

**Note**  This interface is for advanced users only. The software installation configures NCE for the configuration selected during the installation. Only use this when an advanced, non-standard configuration is required.

Configuration interface

As part of the configuration interface, a system tray icon is included.

The following sections show and describe elements of the configuration interface.

Opening panel

1. **Settings categories**  Lists the configuration sub-categories for NCE. By clicking on an option, the panel on the right will be populated with the related settings.
2. **Status bar**  Describes the last action performed during configuration to provide feedback about your actions.
General settings

1 Start button
Selecting this starts the device server portion of NCE.

2 Stop button
Selecting this stops the device server portion of NCE. All state information pertaining to currently pending information host messages will also be reset.

3 Log Verbosity
The verbosity setting can be set between 1-10, but currently only three settings are supported (3, 6, and 9). Any time NCE is configured to something other than these three settings, NCE will reset to the closest available setting. The least verbose setting (1-4) will only write errors that occur within NCE. The middle verbose setting (5-7) will include any errors, device connection information, and top level WACP information. The most verbose setting (8-10) will include everything described before as well as internal information about how the NCE components are communicating with each other.

4 Automatic configuration
This option allows you to fully configure NCE using an existing configuration file. This will copy the specified file to the NCE directory, rename the file to “NCEConfig.xml,” and force the application to restart to reload the new configuration.

Note: This will disconnect any current devices in the same way the Stop button works. This will also restart the Web interface portion of the application to employ any user interface changes.

5 Local Data Cache directory
NCE provides the option to save all device data sent through the system to a local directory. This data is the unaltered data, directly from the device. This configuration option specifies the directory where the cached device data files should be stored, relative to the application directory.

6 Local Data Cache file types
This option allows you to specify what types of data files should be cached locally. You can choose to save the pure binary data from the device, an XML form of the data, or both. Each file is uniquely named using a combination of the device source ID, the current system time, and a randomly generated number.
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>7 Days to Keep</strong></td>
<td>NCE will monitor the Saved Copies folder and do some cleanup in order to keep the number of files in that folder at a manageable level. There is a configurable limit on the age of files saved, with a default set to 7 days. All files older than the configurable number of days will be automatically deleted.</td>
<td></td>
</tr>
<tr>
<td><strong>8 Max Files</strong></td>
<td>There is a configurable limit on the number of files that are allowed at once in the Saved Copies folder. The default will be 5000 files; once that number is reached, the oldest files will be removed when new files are created. Both limits do not need to be reached before NCE will remove files. Once an hour NCE will check both limits and remove files as necessary.</td>
<td></td>
</tr>
<tr>
<td><strong>9 Local Failed Data Cache directory</strong></td>
<td>This option only applies to messages that have failed to respond to the device. If there is an error that cannot complete its round trip, a copy of the original message will be stored here.</td>
<td></td>
</tr>
<tr>
<td><strong>10 Local Failed Data Cache file types</strong></td>
<td>This option allows you to specify what types of failed message data files should be cached locally. You can choose to save the pure binary data from the device, an XML form of the data, or both. Each file is named using a combination of the device source ID, the current system time, and a randomly generated number.</td>
<td></td>
</tr>
<tr>
<td><strong>11 Save settings</strong></td>
<td>Selecting this commits any changes made to the configuration settings. This will update the application settings on the fly, and save the changes to the “NCEConfig.xml” file.</td>
<td></td>
</tr>
</tbody>
</table>
Device network settings

1. **Device transmission timeout**: This value represents the maximum time, in seconds, that a device can be connected to NCE with no communication before the device is disconnected.

2. **Definition cache**: This value represents the local or path to the directory where cached definitions are stored. **Note**: Cached definitions are only loaded when NCE starts, so any additions or updates to these files will not be recognized until the application restarts.

3. **Connection types**: These checkboxes represent the supported connection types for the device server portion of NCE.
   - **TCP**: Port - The TCP Port value is the port number the NCE software will open and listen to connections from devices.
   - **UDP**: Port - The UDP Port value is the port number the NCE software will open and listen to connections from devices. **Note**: The “Serial” option available applies to both normal serial connections, and USB Serial Host Driver connections (for example CP 200 USB).
   **Note**: Changes to this option will not be reflected by NCE until the application is restarted.
Device heartbeats

This value represents the interval (in seconds) at which heartbeat pings will be sent to known client devices. This is a standard ICMP ping echo request, sent to a networking client. When set to "0," heartbeat pings are disabled.

When a client device connects, it will be marked as a known client and flagged as active. Once the interval has elapsed, a ping request will be sent to each known client in parallel. Once a client responds to the request with an echo response, the client will be flagged as active. If any clients have not responded after one second, a retry request will be sent to those clients. Up to four retries will be attempted, and any clients that have not responded after the fourth attempt will be flagged as inactive.

Once the retries have completed, the list of active and inactive device clients will be forwarded to the host system. Once the list is sent, all inactive clients are removed from the device list.
Information network settings

1. Data transmission timeout
   This value represents the maximum time, in seconds, that a connection will be maintained with an external information host. If no response is received from an information host within this time interval, for a specific message context from a device, NCE will send a NACK to the relative device and close the connection to the information host.

2. Multiple external host management
   This option allows NCE to act as a message branch, and forward device messages to multiple external host systems. Each message received from a device will be duplicated and sent to each host specified in this list. Each host has its own related configuration page and information, and can specify separate IP addresses, payload options, and transform sheets. The Add/Remove buttons are used to add new, blank host information pages, and remove currently selected host information pages based on the displayed index. Since a single device message can be branched to multiple host information systems, the “Host Authority” option (XREF) allows you to specify how the responses from these hosts should be used to determine the success state of the transmission.

3. Host authority
   This option identifies whether the currently selected external host should be used to determine the success state of a data transmission or not. This is primarily used when multiple external hosts are configured for NCE.

4. File output
   This option specifies whether the output should be written to file instead of forwarded to an external host, and to what directory the output file should be written.
5 Automatic host resolution

In certain system configurations, the IP address of the external host is either not known at configuration time, or not static. In these cases, the IP address of the host cannot be determined ahead of time, and must be resolved at the time that connections to the host are attempted. This feature uses an integrated DCP client to find hosts automatically when devices send messages to NCE.

When this option is enabled, the “Host IP Address” and “Host Port” fields are disabled, as this setting overrides those options. Also, the “Host Type” option becomes enabled, and lets you choose which hosts they would like to find automatically when messages are routed through the system.

6 Host type

When the “Automatic Host Resolution” option is enabled, this option becomes available. It lets you choose which external host types to look for when finding automatic hosts.

There are two fields associated with this option—an manually edited numeric field, and a dropdown box of predefined selections. If no host types are known that match the index, a value of “Unknown” is displayed.

7 Host address

This is the IPv4, dot-separated address, or DNS lookup name for the external information host where device data will be forwarded.

Note: The connection established with the information host is a standard TCP connection.

8 Host port

This is the application port value available on the external information host where NCE will connect.

9 Reuse connections

This option enables or disables the connection reuse algorithm. When this option is enabled, messages from all devices to a single information host will be routed through a single, established connection, synchronously. If no connection is available, a new connection is established.

When this option is disabled, a new asynchronous TCP connection is established every time a new data message is forwarded to an information host.

10 SSL option

This option enables or disables the use of SSL (Secure Sockets Layer) encryption when communicating with an information host.

When this option is enabled, an SSL session is established whenever a connection is made to the configured information host. All messages that are transmitted to the information host are then encrypted with the SSL algorithms.

When this option is disabled, a standard, un-encrypted TCP connection is used.

11 Payload type

This option determines if NCE will forward WACP-formatted XML data, or binary data to external information hosts.

Note: If an outbound XSLT file is specified, the WACP-formatted XML is translated using that file and then sent. If no file is specified, the XML is sent directly without translation.

12 XSLT Clear

These buttons will clear the selected XSLT file for the associated field. This will not delete the XSLT files from the related directory. It will only remove the assignment of that XSLT file for message processing in NCE.

13 Outbound XSLT

The outbound XSLT field is used to specify the location of an .xsl file that will be used to translate data from a device to the format accepted by the information host. You can browse for an .xsl file, which will be copied and saved to NCE's own local storage directory. All data collected from devices is translated from the native binary format from the device to the XML format. At that point, the XML data is then transformed using the provided outbound XSLT sheet, and forwarded to the specified external information host. This allows an administrator to provide a specialized transformation sheet designed for the information host that will format the data to fit the needs of the information host's interface.
Configure SSL for mutual authentication

Certificates

Follow the Generate a Root Authority only if the instance does not already exist. If your vendor provides a Root Authority skip to the "RootCATest".

Generate a Root Authority

Follow these steps:

makecert -sv RootCATest.pvk -r -n "CN=FakeServerName" RootCATest.cer
makecert -ic RootCATest.cer -iv RootCATest.pvk -n "CN=FakeServerName" -sv TempCert.pvk -pe -sky exchange TempCert.cer

Import RootCATest.cer into your Computer store’s Trusted Root Certification Authorities (on both the server and client).

Notice that the certificate is issued to FakeServerName. This must match the server name that the SslTcpClient expects:

sslStream.AuthenticateAsClient(serverName), where serverName is the value of the second argument passed to SslTcpClient.exe.

Generate client and server certificates

makecert -crl -n "CN=FakeServerName" -r -sv RootCATest.pvk RootCATest.crl
makecert -pe -n "CN=FakeServerName" -a sha1 -sky exchange -ic RootCATest.cer -iv RootCATest.pvk -sv ClientCert.pvk ClientCert.cer
openssl rsa -inform DER -in ClientCert.cer -out ClientCert.crt openssl pkcs12 -in ClientCert.pfx -nocerts -nodes -out ClientCert.key

Then open the ClientCert.key file and remove everything before ----BEGIN PRIVATE KEY-----

When your client connects, the server presents a certificate that tells the client "I'm FakeServerName'. The client will accept this claim if the client machine trusts the CA that issued the certificate, which is achieved by importing RootCATest.cer into the client’s Trusted Root Certification Authorities.

Import the Certificate Revocation List (RootCATest.crl) on the Server and Client machines.
Import the private key that the server is going to use into the server machine’s Personal store.

**Note**  This step is important because it addresses the server mode. SSL must use a certificate with the associated private key. This is achieved by importing the .pfx file generated earlier.

Make sure that you change the file type filter to "all files" so that you can see the .pfx file that you generated:
Client Side (NCE)

NCE uses the `ClientCert.crt` and `ClientCert.key` files using `SSL_use_PrivateKey_file` and `SSL_use_certificate_file`. These files are set by browsing to the certificate located in the “Certificate file used for two-way (mutual) SSL authentication” section. The Key file is not required, but can be loaded in the “Key file for two-way (mutual) SSL authentication”.

![NCE Configuration](image)

Server Side (C# App)

SslTcpServer:

```csharp
TcpListener listener = new TcpListener(IPAddress.Any, 8080);
```

SslTcpClient:

```csharp
TcpClient client = new TcpClient(machineName, 8080);
```
Launch your server:

`SslTcpServer.exe TempCert.cer`

Connect from the client:

`SslTcpClient.exe <ip to your server> FakeServerName`
User interface settings

1 Web port  
The port value that will host the Web interface for NCE.  
**Note:** Any changes to the web port value will force the web-interface portion of NCE to restart. This means you must close the interface and re-open it to continue configuration.

2 Interface enabled  
This option enables or disables the Web interface. If this is enabled, the application can be configured as normal through the configuration interface. If this is disabled, you will not be able to access the configuration interface.  
**Note:** The only way the interface can be re-enabled after being disabled is to stop the application, manually edit the “NCEConfig.xml” file to enable the interface, and restart the application.
Data logs

To provide assistance in monitoring messages that are processed by NCE, specifically ones that fail to complete their round-trip delivery, a Data Log option is available on the left side of the configuration interface. This option will open a new window and display a list of data messages that have been received from devices by NCE, but for some reason have not completed their process successfully.

This log displays information contained within the data messages themselves (for example Patient ID, Date/Time, Serial Number of the device, etc) to help determine if the error was a result of improper device data, or if it was from an internal processing error.

For the Data Log option to work, NCE must have the Failed Data Cache option enabled (see “Local Failed Data Cache directory” on page 19), and must have XML formatted data enabled for this option (see “Local Failed Data Cache file types” on page 19). If either of these options are missing or not enabled, the Data Logs will not be available.

Debug logs

The NCE application generates a running log with debug information as it executes. It maintains two logs (“DebugLog1.txt” and “DebugLog2.txt”) that store this information, and writes to the two files in a circular manner. When the application starts, it opens “DebugLog1.txt” to write first, and continues to write information to this file until it reaches the specified capacity (10 Megabytes). Once this limit has been reached, the application opens “DebugLog2.txt” and continues writing until once again the capacity limit has been reached. Then, the application reopens “DebugLog1.txt”, clears all data from the file, and continues writing.
File Importer configuration

File Importer is a software program that allows you to transfer patient vitals from an external media drive into CardioPerfect.

Options tab

The options tab allows you to change your configuration settings.

1. Outgoing file folder - This is the folder containing a copy of the files sent to the Information Host.
2. Failed file folder - Folder containing a copy of the files that failed to send to the Information Host.
3. External media drive - Disk drive representing the removable media where the tests are stored.
4. External media folder - Folder on the removable media containing the tests to be imported.
5. File types to import - File types (extensions) that the software will look for in the External Media Folder on the External Media Drive to import.
6. Information host address - Web address of the web service where the files are to be sent. The only part that could be configured is the “localhost:9247.”
Logs tab

The Logs tab allows you to read logged messages to either confirm a test was imported correctly or determine why an import failed.

![Logs tab screenshot]

Import failures tab

This tab shows a list of files (tests) that were not able to be imported.

![Import failures tab screenshot]

1. **Delete**  Allows you to remove this file from the system.
2. **Retry**   Allow you to correct the problem and retry to send the file.
Configuration

Welch Allyn Connex® Device Integration Suite (CDIS) Network Connectivity Engine (NCE) software
Troubleshooting

About the connectivity software modules

The Connex® Device Integration Suite (CDIS) Network Connectivity Engine (NCE) software comprises a set of modules that are installed separately as needed. The connectivity modules are listed here:

<table>
<thead>
<tr>
<th>Module</th>
<th>Full name</th>
<th>Description</th>
<th>Installation location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPSAPI</td>
<td>CardioPerfect Server</td>
<td>This is the database connectivity module. It plays a central role, directing communications between various software modules and the server software.</td>
<td>One CPSAPI per site</td>
</tr>
<tr>
<td></td>
<td>Application Programming</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NCE</td>
<td>Network Connectivity Engine</td>
<td>This module receives data from the device(s).</td>
<td>One NCE per CPSAPI installation and per Workstation that supports wired-USB</td>
</tr>
<tr>
<td>DCP</td>
<td>Device Communication Protocol</td>
<td>This module listens for device(s) that are connected wirelessly, and it tells them which IP address to communicate with.</td>
<td>One DCP per subnet</td>
</tr>
<tr>
<td>FI</td>
<td>File Importer</td>
<td>This module receives tests from removable media (SD memory cards or USB storage devices).</td>
<td>One FI per Workstation receiving tests via removable media</td>
</tr>
</tbody>
</table>

Firewall settings

If you are using a firewall between any PCs in your configuration, the following ports or application files are required to gain access through the firewall. Software installation automatically opens these ports.

<table>
<thead>
<tr>
<th>Software module</th>
<th>Port</th>
<th>Type</th>
<th>Application file</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPSAPI</td>
<td>9247</td>
<td>TCP</td>
<td>CPWS.Service.exe</td>
</tr>
<tr>
<td>DCP</td>
<td>44435</td>
<td>UDP</td>
<td>DCP.exe</td>
</tr>
<tr>
<td>DCP</td>
<td>7711</td>
<td>UDP</td>
<td>DCP.exe</td>
</tr>
<tr>
<td>NCE</td>
<td>281</td>
<td>TCP</td>
<td>NCE.exe</td>
</tr>
<tr>
<td>CP 200</td>
<td>ICMP</td>
<td>Allow incoming echo requests</td>
<td>Ping test</td>
</tr>
</tbody>
</table>
Functional diagrams

Software modules in a standalone CardioPerfect Workstation, removable media or USB

Related illustration: "Standalone configuration, removable media or USB" on page 5

Software modules in an Ethernet network configuration
Software modules in a client-server configuration, removable media or USB

Related illustration:
"Client-server configuration, removable media or USB" on page 5

Software modules in a client-server and Ethernet network configuration

Related illustration:
"Client-server network configuration, wireless or Ethernet" on page 4
Software modules in a simple network configuration, wireless or Ethernet

Software modules in a USB configuration

Related illustration:
"Client-server network configuration, wireless or Ethernet" on page 4

Related illustration:
"Client-server configuration" on page 4
Reassigning a server IP address

Who needs this procedure?
Users with a client-server configuration wired to the client PC(s) or communicating via removable media.

When do you need this procedure?
Anytime your server IP address changes.

What does this procedure accomplish?
It enables the software to pick up a newly assigned server IP address.

How do you do this procedure?
Restart the computer’s DCP daemon Windows service.

a. Go to Control Panel > Administrative Tools > Services.
b. Right-click DCP.
c. Select Restart.

No action is required at the client PC(s).
## Troubleshooting chart

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Causes</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>There are no wireless networks available.</td>
<td>Verify that the wireless network router(s) are powered up and properly configured.</td>
</tr>
<tr>
<td></td>
<td>Device radio is not connected.</td>
<td>Connect CP 150 radio. Verify that the CP 150 radio lights are blinking or solid to indicate action.</td>
</tr>
<tr>
<td></td>
<td>Device configuration.</td>
<td>Check the CP 150 network settings and connectivity mode. Verify that these settings match the access point settings.</td>
</tr>
<tr>
<td></td>
<td>The device cannot connect to the network.</td>
<td>Check wireless settings and ensure that they match the access point settings.</td>
</tr>
<tr>
<td>2. Ping operation failed.</td>
<td>Wrong IP address entered.</td>
<td>Check other computer’s IP address.</td>
</tr>
<tr>
<td></td>
<td>The device cannot properly connect to the network.</td>
<td>Wireless: Check wireless settings and ensure that they match the access point settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet: 1. Connect the network cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Wait a few seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Navigate to the network setting screen and verify that the device has a valid IP address.</td>
</tr>
<tr>
<td></td>
<td>Firewall settings.</td>
<td>The firewall needs to be set to “Allow echo requests.” (See “Firewall settings” on page 33.)</td>
</tr>
<tr>
<td></td>
<td>Device configuration.</td>
<td>Check the device network settings and connectivity mode. Verify that these settings match the access point settings.</td>
</tr>
<tr>
<td>3. Server test operation failed.</td>
<td>The device cannot properly connect to the network.</td>
<td>Wireless: Check wireless settings and ensure that they match the access point settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet: 1. Connect the network cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Wait a few seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Navigate to the network setting screen and verify that the device has a valid IP address.</td>
</tr>
<tr>
<td></td>
<td>Connectivity software not installed on a computer on the network.</td>
<td>Install CDIS-NCE on the same computer as CardioPerfect database.</td>
</tr>
<tr>
<td></td>
<td>DCP module is not running.</td>
<td>Check the services to verify that the DCP daemon service is running.</td>
</tr>
<tr>
<td></td>
<td>Firewall settings.</td>
<td>Check firewall to ensure that exceptions are set. (See “Firewall settings” on page 33.)</td>
</tr>
<tr>
<td></td>
<td>Device configuration</td>
<td>Check the device network settings and connectivity mode. Verify that these settings match the access point settings.</td>
</tr>
<tr>
<td></td>
<td>The server IP address has changed.</td>
<td>See “Reassigning a server IP address” on page 37.</td>
</tr>
<tr>
<td></td>
<td>Multiple subnets.</td>
<td>Check your network router settings; enable multicasting across subnets.</td>
</tr>
<tr>
<td></td>
<td>Unknown</td>
<td>1. Determine the IP address of the PC running NCE.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Perform a ping test to this IP address. If the ping test passes, the network connection is OK.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Perform a server test, if the server test fails then either DCP or NCE is not running or in error state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Restart the DCP or NCE, and try the server test again.</td>
</tr>
<tr>
<td>Conditions (continued)</td>
<td>Causes (continued)</td>
<td>Actions (continued)</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>4. Test send (or patient search) failed - wireless or ethernet.</td>
<td>No patient order found or patient search contained no results</td>
<td>Server does not contain any patients that match the search criteria.</td>
</tr>
<tr>
<td>The device cannot properly connect to the network.</td>
<td>Wireless: Check wireless settings and ensure that they match the access point settings. Ethernet: 1. Connect the network cable. 2. Wait a few seconds. 3. Navigate to the network setting screen and verify that the device has a valid IP address.</td>
<td></td>
</tr>
<tr>
<td>Outside range of all wireless networks.</td>
<td>Move within the wireless network.</td>
<td></td>
</tr>
<tr>
<td>There are no wireless networks available.</td>
<td>Verify that the wireless network router is powered up and properly configured.</td>
<td></td>
</tr>
<tr>
<td>Device radio is not connected (CP 150 only).</td>
<td>Connect CP 150 radio. Verify that the radio lights are blinking or solid to indicate action.</td>
<td></td>
</tr>
<tr>
<td>Connectivity software not installed on a computer on the network.</td>
<td>Install CDIS-NCE on the same computer as CardioPerfect database.</td>
<td></td>
</tr>
<tr>
<td>DCP module is not running.</td>
<td>Check the services to verify that the DCP daemon service is running.</td>
<td></td>
</tr>
<tr>
<td>NCE is not running.</td>
<td>Check the services to verify that the NCE service is running.</td>
<td></td>
</tr>
<tr>
<td>NCE is not receiving files.</td>
<td>Verify that the C:\Program Files\Welch Allyn\NCE\SavedCopies folder has new files with a date/time stamp about when you sent it and that the folder updates as you send more tests. 1. If yes, NCE is getting files. Check CPSAPI. 2. If no, NCE is not working. Reinstall server software or check firewall.</td>
<td></td>
</tr>
<tr>
<td>CardioPerfect services (CPSAPI) is not running.</td>
<td>Verify that the CardioPerfect Services service is running.</td>
<td></td>
</tr>
<tr>
<td>CP 150 configuration.</td>
<td>Ensure that Connectivity Mode is set to Wireless.</td>
<td></td>
</tr>
<tr>
<td>The server IP address has changed.</td>
<td>See “Reassigning a server IP address” on page 37.</td>
<td></td>
</tr>
<tr>
<td>Firewall settings.</td>
<td>Check firewall to ensure that exceptions are set. (See “Firewall settings” on page 33.)</td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>1. Determine the IP address of the PC running NCE. 2. Perform a ping test to this IP address. If the ping test passes, the network connection is OK. 3. Perform a server test, if the server test fails then either DCP or NCE is not running or in error state. 4. Restart the DCP or NCE, and try the server test again.</td>
<td></td>
</tr>
<tr>
<td>NCE is not receiving files</td>
<td>Check to make sure the proper device connection type is enabled: 1. Open the NCE configuration page through the system tray icon. Click on Device Network on the left. 2. Check Supported Connection Types to make sure the proper channels are enabled. Note: WiFi connections from devices require TCP to be enabled. USB connections from the CP200 require Serial to be enabled. 3. Click Save Settings to save your changes 4. If using WiFi wireless connectivity, verify that the device wireless settings (SSID, etc.) matches the network settings.</td>
<td></td>
</tr>
<tr>
<td>Conditions (continued)</td>
<td>Causes (continued)</td>
<td>Actions (continued)</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>5. Test send (or search) failed - USB cable</td>
<td>Cables not connected.</td>
<td>Make sure USB cable is connected on both ends (device and PC).</td>
</tr>
<tr>
<td></td>
<td>Connectivity software not installed.</td>
<td>Install Server Connectivity option on the computer containing the database, and install the Client option on the USB computer. Ensure that the device is connected and the PC driver is loaded.</td>
</tr>
<tr>
<td></td>
<td>CP 200 configuration.</td>
<td>Ensure that Configuration Mode is set to Wired.</td>
</tr>
<tr>
<td></td>
<td>NCE is not running.</td>
<td>Check the services to verify that the NCE service is running.</td>
</tr>
</tbody>
</table>
|                        | NCE is not receiving files. | Verify that the C:\Program Files\Welch Allyn\SavedCopies folder has new files.  
- If yes, NCE is getting files. Check CPSAPI.  
- If no, NCE is not working. Reinstall Client software or check firewall. |
|                        | CardioPerfect services (CPSAPI) is not running. | Verify that the CardioPerfect Services service is running on the computer containing the database. |
|                        | The server IP address has changed. | See “Reassigning a server IP address” on page 37. |
|                        | Firewall settings. | Check firewall to ensure that exceptions are set. (See “Firewall settings” on page 33.) |
|                        | Incorrect cable. | CP 50 and CP 150: Verify that you are using an A-to-mini-B USB cable.  
CP 200: Verify that you are using an A-to-A USB cable.  
NCE is not receiving files. Check to make sure the proper device connection type is enabled:  
1. Open the NCE configuration page through the system tray icon. Click on Device Network on the left.  
2. Check Supported Connection Types to make sure the proper channels are enabled.  
   Note: WiFi connections from devices require TCP to be enabled. USB connections from the CP200 require Serial to be enabled.  
3. Click Save Settings to save your changes  
4. If using WiFi wireless connectivity, verify that the device wireless settings (SSID, etc.) matches the network settings. |
|                        | NCE is not receiving files | Check to make sure the proper device connection type is enabled:  
1. Open the NCE configuration page through the system tray icon. Click on Device Network on the left.  
2. Check Supported Connection Types to make sure the proper channels are enabled.  
   Note: WiFi connections from devices require TCP to be enabled. USB connections from the CP200 require Serial to be enabled.  
3. Click Save Settings to save your changes  
4. If using WiFi wireless connectivity, verify that the device wireless settings (SSID, etc.) matches the network settings. |
| 6. Test send failed - removable media | Connectivity software not installed. | Install Server Connectivity option on the server containing the database, and install the Client option on the USB computer. Ensure that the device is connected and the PC driver is loaded. |
|                        | Client software is not installed on the computer intended to be the transfer station. | Install the Client software option on the computer intended to be the transfer station. |
|                        | Tests not on removable media. | Refer to the device’s directions for use for details on sending tests to memory card. |
|                        | File Importer is configured for "Auto," but it ignores drives A and B. | Set File Importer to select the proper external media drive. |
|                        | File Importer reports a failure. | Verify that client and server have connectivity and that CPSAPI is running, then retry: Right-click the File Importer tray icon, select “Import Failures,” select the failed file(s), and press Retry. |
|                        | File Importer has been manually disabled. | Right-click the File Importer tray icon, and uncheck the “Disable” menu. |
|                        | The server IP address has changed. | See “Reassigning a server IP address” on page 37. |
### Conditions (continued) | Causes (continued) | Actions (continued)
--- | --- | ---
7. NCE configuration page is inaccessible | The configuration web-interface has been disabled | 1. Open **NCEConfig.xml** (located in the NCE installation directory) with a text editor.  
2. Search for “InterfaceEnabled.” On the line following this term, find the section that reads “<![CDATA[0]]>.”  
3. Edit the file and replace the 0 with a 1, so the entry reads: “<![CDATA[1]]>.”  
**Note:** If the entry already reads “<![CDATA[1]]>”, then the web-interface is enabled and something else is causing the access issue.  
There is another application already running on the PC which is using the port the web-interface would normally use.  
1. Open **NCEConfig.xml** (located in the NCE installation directory) with a text editor.  
2. Search for “ListenPort.” On the line following this term, find the section that reads “<![CDATA[8000]]>.” The 8000 may be another numerical value, if the web-interface port was changed in the past.  
3. Edit the file to replace the 8000 with a new port value, one that you know no other application is currently using.
8. CPWS patient number has \texttt{SUSPECT} appended to the patient number | The CP 200 patient-match criteria is only partially satisfied. | See “Configuring the CP 50, CP 150, and CP 200 patient-match criteria (resolving patients)” on page 13.
9. Datamed interface is not working | The plug-in is not enabled. | See “Configuring the CardioPerfect Workstation for non-Welch Allyn devices” on page 15.